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1
About the Reporting Server

WebTrends Enterprise Reporting Server provides real-time Web visitor 
analysis on an ongoing basis—and more sophisticated analysis when 
necessary—for users with high traffic and multiple clients, such as Internet 
Server Providers, server farms, and large enterprises. The built-in web server 
publishes reports automatically, making them available to remote users 
through their web browsers. In addition to the browser-based user interface, 
the program can also be run and configured from the command line. See 
“Running from the Command Line” on page 123 for details.

Administrators can manage all aspects of the Reporting Server remotely.

The Reporting Server creates comprehensive summary reports on web site 
visitor behavior. The reports, which can be viewed remotely via a browser, are 
a key asset for quickly judging site performance, response trends, and so 
forth.

The Reporting Server should be installed on a system that can access the 
web server log files either locally, through a mounted drive, or transferred 
using FTP. The platform of the client machines viewing reports is irrelevant, as 
long as the correct web browser is installed. See “System requirements” on page 
22 for browser requirements.

Reporting Server features
The Reporting Server has the following features:

• Web Server Traffic Analysis—Lets you report on all aspects of your 
web site’s activity, including how many people are visiting your web 
site, where they come from, and what pages interest them most.

• Support for Multiple Servers—ClusterTrends™ technology lets you 
get accurate reports for sites hosted by multiple servers. 
ClusterTrends can be implemented if you have a Server Add-On 
license.

• Report Template Designer—Lets you choose the colors, fonts, 
layouts, and content to use in your reports.

Introduction 1
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• Comprehensive Reports—Reports are created and maintained 
automatically at regular intervals, eliminating the need to run several 
individual reports manually. Generate weekly, monthly, quarterly, and 
yearly reports that focus on the content you choose.

• User Access Management—Lets you grant permissions and default 
settings on an individual basis. A range of permissions is possible, 
from program-wide access as an administrator to reporting ability with 
viewing report access. You can pre-configure profile settings for any 
or all users, making their work easier. Users only view the reports and 
program features they have access to.

• Remote Configuration—Not only can you access reports remotely, 
but also profile settings, user accounts, and all other program 
features.

• Customizable Interface—Many dialogs in the interface are optional 
and can be disabled for non-administrators. You decide if those 
dialogs are visible to your users.

• Profile archiving—lets you back up profile databases at regular 
intervals which you can use to restore the profile at a later date.

• Advanced features—Lets you create global definitions that can make 
your analysis more informative. Advanced features deal with pages 
that you want to group together, shopping cart software that prevents 
you from getting accurate reports, dynamic pages, and frequently 
traveled paths through your site.

New features are added frequently.  Refer to our web site at http://
www.webtrends.com for the latest information.

New features
This version of the Reporting Server includes:

• Pre- and post-processing function, which allows administrators to add 
tasks which CommerceTrends can start prior to or after completing a 
profile analysis. See “Pre- and post-processing” on page 33.

• Enhanced filter functions. See Chapter 4, "Using Filters" on page 57.

• Enhanced reporting. See “Building Reports” on page 83 for details.

• Changes to how the Reporting Server performs URL parameter analysis, 
and uses cookies.
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Documentation and Help

What typographic changes mean
The following table describes the typographic changes used in this guide.

Table 1-1.   Typographical Changes

See the Glossary in the Reporting Server online help, or at the WebTrends 
web site to clarify any terms used in the Reporting Server or the 
documentation which may be new to you.

Making documentation available to non-administrators
A user guide for non-administrators is also available. We urge you to make 
the User’s Guide available on your intranet or network.

The user guide can be viewed online using Adobe Acrobat.   If you purchased 
the CD-ROM version of the Reporting Server, you can get the .pdf file from 
the CD. Otherwise, you can download the manual from the Support section of 
the WebTrends Corporation web site.

To download the .pdf version of this manual:

1. Open your browser.

2. Type following URL: http:// www.webtrends.com.

This text Represents

Bold The name of an icon or button (New), a text box (Base Time text 
box), or check box (Save User ID check box in the user 
interface). 

Title Case The name of a window (Add Profile window) or a dialog box (Edit 
Connection dialog box),

courier 
font

Source code examples, program output, or anything typed by the 
user. 

Italics The first use of a new term, or an emphasized word.

“in quotes” The title of a chapter or section.

http://www.webtrends.com
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3. From the WebTrends Corporate home page, click Support. The 
Product Support Page opens (Figure 1-1), showing a selection of 
WebTrends documentation available for download.

 Figure 1-1.   Documentation list on Product Support page

4. Under the Manuals heading, click Download to view the manuals 
available for download.

Getting help in the program
The Reporting Server provides online help to guide you through the program. 
Look for the Help button in program dialogs. If you’re not sure about what to 
type in a text box, click the Help button. Open the online help at any time by 
selecting the Help menu from the Main Console.

Additional resources
A glossary of terms used in the Reporting Server can be found in the 

The WebTrends portal for Internet and Intranet professionals is a great 
resource for Web related information, industry news, reviews, and other 
useful information. Visit http://www.WebTrends.net to see for yourself.

http://www.webtrends.net
http://www.webtrends.net
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About the Remote Interface
This chapter explains how to log in to the Reporting Server and how to use 
the program through the Remote Interface. 

Using the Main Console. 
From the Main Console (Figure 2-1 on page 12), you can run reports and 
work with profiles according to the rights you’ve been given. 

Tip: When you log in, the Main Console opens.  You can turn the browser toolbar 
on or off using the Browser Toolbar command on the File menu.

1

The Reporting Server 2
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 Figure 2-1.  Remote interface main console

Using the WebTrends profiles tab
The WebTrends Profiles tab displays any profiles you have access to. If you 
have access rights, you may be able to add profiles, or modify and delete 
profiles.

Sample profiles are included so that you can get familiar with the Reporting 
Server and run sample reports. 

Using the menu
Table 0 - 1 The menu bar provides access to all program functions. 

Menu Provides

File Commands for working with profiles and reports and exiting the 
program.

View Status of the selected profile. Also allows the user to include their 
default browser toolbar above the Reporting Server console.
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Using the toolbar
The toolbar provides quick access to the most used commands.

Note:  Only the commands for which you have access rights
are available on the toolbar.

Table 0 - 2 Toolbar commands

Help Access to the Help Table of Contents, the WebTrends 
Corporation web sites, and the About box.

Feedback The Reporting Server feedback form. Let us know what you think.

Button Purpose

Reports Displays the Report window where you view the report for the 
selected profile.

New Displays the Profile Wizard for creating a new profile.  All 
analysis and reporting is based on profiles.

Edit Displays the Edit Profile dialog where you can change the 
selected profile settings.

Delete Removes the selected profile from the list (only displayed if 
you have been granted delete rights)

Help Displays the online help, where you’ll find detailed 
information on all Reporting Server dialogs.

Support Opens the Support area of the WebTrends web site.

Menu Provides
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3
About Reporting Server analysis

Reporting Server reports are based on profiles which define the location of 
your web server log file and how the log file should be analyzed. A profile 
provides the following data:

• Whether your web site resides on a single server or on multiple 
servers (including server clusters)

• Log file type and location

• Home page location and default pages for your site

• The filters to apply

• Which cookie to use

• Whether you are creating pre-generated or on-demand reports

• Reporting template to use

• Report header settings

• Reports to create

• Schedule for updating reports

• DNS lookup method

• Users who can access the profile

• Location for report data

Important: If you have been granted administrative rights, you can add, edit, and 
modify all profiles, even those created by other users. If you have not been granted 
administrative rights, many of the options explained in this chapter may not be 
available to you.

Using Profiles 3
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Preparing to analyze web site activity
To set up a new profile to analyze your site’s activity, you’ll need to answer the 
following questions:

• Does your site reside on a single server or on multiple servers? 
If your site is on more than one server (such as in a server cluster 
configuration), you’ll need to know the location of the servers and 
where your logs reside on the servers. Also, be sure you have the 
proper licensing if you are reporting on activity for multiple servers.

• Where are log files stored? You’ll need the exact file path to your 
log files.

• What is the naming convention used for log files? For example, 
log files might be named according to date followed by a .log 
extension (such as 990111.log). If log files are compressed they may 
have a .zip, .gz, or .tar extension.

• What is the rotation of your log files? You’ll need to know if they 
are rotated, and if so, on what schedule: daily, monthly, and so on.

Note:  You must purchase and install a Server Add-on with ClusterTrends to 
analyze web sites whose logs reside on multiple servers.

Adding a profile
This section walks you through configuring a profile using the Profile Add 
wizard. These screens can also be accessed through the Profile Edit dialog 
box.

Important: If you are using the Reporting Server’s Campaign Analysis feature, 
you must configure your profile to include the Marketing Campaign definitions and 
Product definitions you want included in reports for this profile. While you can 
always edit a profile to include new definitions, it is most efficient to have these 
definitions in place before you build a profile that uses them.

To add a new profile to the Reporting Server:

1. From the Main Console, click New on the toolbar. The Site 
Configuration dialog box opens (Figure 3-2).
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 Figure 3-2.  Site Configuration dialog box

2. Specify your site’s configuration:

• Select My web site is on one physical machine f your web site 
resides on one server.

• Select My web site is on multiple physical machines if your 
web site is on more than one server. With the ClusterTrends Add-
On, the Reporting Server can analyze web site activity for sites 
that reside on multiple servers.

Click Next to save your settings and continue.

3. The Profile Add dialog box opens with the General tab showing 
(Figure 3-3). Type a name for the profile in the text box. This name 
also serves as a default profile title in generated reports.
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 Figure 3-3.  Profile Add dialog box

4. Specify how much of the log to analyze.

• Select From the start of the log file to analyze the entire log file.

• Select From the following date to analyze the log beginning 
with the date specified. Type the date in day/month/year format.

Click Next. The Log File Path dialog box opens (Figure 3-4 on page 19).

Specifying log file location

Important: This is the most important step in creating a profile. Without the 
location of the log file, the program cannot access or analyze the activity on your 
web site.
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 Figure 3-4.  Log File Path dialog box

5. If you are analyzing log file data which is stored on multiple or 
clustered servers, please see “Setting up servers for ClusterTrends 
profiles” on page 22 for instructions. If you are analyzing log file data 
which is stored on a single server, continue with Step 6 below.

6. Click Browse to navigate to the directory that contains the file you 
want to analyze. The file name is displayed in the Current File text 
box.

7. Click Add to move the current file to the files list.

8. Repeat steps 7 and 8 until you have created the file list that you want 
to use in your profile.

9. Click one of the following:

• Append adds the files in the Files List to the text in your existing 
entry. For example, if you are building a list of log files to import, 
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clicking Append adds to any already specified in the Log File 
URL Path. 

• Replace uses the files in the Files List to replace your existing 
entry.

Note: If you get a message stating that the profile has failed to initialize, verify 
that the log file path that you entered is correct. See “Understanding log files” on 
page 84 for an overview of log files.

10. If the specified log files are accessed using FTP and the server 
requires the user to authenticate, type the login information in the 
Username and Password text boxes.

The following table provides examples of how to format your entry.

Table 0-1.  Log file URL path format examples

Example Description

ftp://ftp.domain.com/logs/
mylog.log

Specifies the complete path to the log files 
accessed using FTP.

ftp://ftp.domain.com/logfiles/
ex990701.log|ftp://ftp.domain.com/
logfiles/ex990730.log 

Specifies two logfiles, ex990701.log and 
ex990730.log in the logfiles directory on the 
ftp.domain.com server.

Notice that the file paths are separated with a 
pipe character.

(UNIX) httpd/logfiles/access_log Specifies the access_log in the httpd/logfiles 
directory.

(UNIX) httpd/logfiles/
access_log\%date-
1%%mm%%dd%%yy%

Specifies the previous day’s activity for a log file 
named according to date. 

(NT) c:\\winnt\logfiles\ex*.log Specifies all the logs beginning with ex in the 
winnt\logfiles directory.

(NT) \\utah\winnt\logfiles\ex*.log Specifies the UNC path for all logs beginning 
with ex in the winnt\logfiles directory on the 
machine named utah.

(NT) \\webserver\logfiles\%date-
1%%mm%%dd%%yy%.log

Specifies the previous day’s activity for a log file 
named according to date.
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11. When you have completed configuring the log file location 
information, click Next to continue with the Profile Add wizard (In 
Profile Edit mode, click OK to save your changes.)

Specifying home page location and file names

12. The next Profile Add screen is the Home dialog box (Figure 3-5). (In 
Profile Edit mode, click Edit on the toolbar, then select the Home tab 
to open.) 

Note: To include page titles in reports, you must also check the HTML Page 
Titles text box in the General options tab.

 Figure 3-5.  Home dialog box

13. In the Home Page File Names text box, type the file names that the 
web server defaults to when a visitor enters a URL without entering a 
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specific file name. Separate multiple file names with spaces. You can 
type up to 255 characters.

Specifying default home pages lets you report all references to the 
home page whether or not the visitor specifically included the file 
name. This makes the home page hit count more accurate.

14. In the web site URL text box, specify the URL to the root of your web 
site, including the access method (http://, ftp://, or file:///).

Suppose that you specified your home page file name as default.htm 
and the web site URL as http://www.WebTrends.com.

• A hit to http://www.WebTrends.com/ is identified as:

http://www.WebTrends.com/default.htm 

• A hit to http://www.WebTrends.com/reports/ is identified as:

http://www.WebTrends.com/reports/default.htm

15. Select the profile to work with, and click Edit.

16. Select the General dialog, and click in the Disable Profile check box.

17. Click OK. The profile is disabled until you clear the Disable Profile 
text box.

Setting up servers for ClusterTrends profiles

If your web site resides on more than one server such as a server cluster or 
farm, set up the servers to analyze here. For each server, specify the location 
of the log files.

Note: If you are not using the ClusterTrends product in conjunction with the 
Reporting Server, this wizard will not appear.

Complete these steps:

18. Select the ClusterTrends profile to work with, and click Edit.

19. Select the List of Servers tab.

20. Select the log file format from the list. The Server Names list includes 
any servers that have been defined for this web site.

21. Click Add to define a new server. The Specify New Server dialog box 
opens.

22. Type a name to identify the server in the Server Name text box.
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23. Type the path to the log file in the Log File Path text box. Logs that 
are accessed using FTP should be identified by using the following 
syntax:

ftp://ftp.domain.com/filepath

where domain.com is the FTP server and filepath is the complete 
path to the log files. Type each log file path on a separate line.

24. If the log files are accessed using FTP and the server requires users 
to authenticate, provide the authentication information in the 
Username and Password fields.

25. Click Next to continue. (In Profile Edit mode, click OK to save your 
settings.)

Specifying filters

26. The next Profile Add page is Filters. (In Profile Edit mode, click Edit, 
then select the Filters tab to open). The Filters dialog opens (Figure 3-
6).
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 Figure 3-6.  Filters dialog box

27. See “Adding an Include or Exclude Visit Filter” on page 58, or “Adding an 
Include or Exclude Hit Filter” on page 65 for details on configuring filters.

When you have completed configuring filters, click Next. (In Profile 
Edit mode, click OK to save your settings.)

Specifying the cookie to use

28. The next Profile Add screen is the Cookies dialog (Figure 3-7 on page 
25). 
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 Figure 3-7.  Cookies dialog box

The Reporting Server uses cookies to identify unique user sessions 
during the analysis. A cookie is a file sent with the page requested 
from the server to the visitor. Cookies are stored on the visitor’s 
system. The stored cookie is then included in subsequent requests to 
your site by this visitor and is recorded in the log file, enabling you to 
uniquely identify the visitor. Activating cookies makes user session 
data more accurate because each visitor is clearly distinguished.

29. If you want to use cookies in the analysis for this profile, click in the 
Use Cookies To Identify User Sessions check box.

30. Select one of the following:

-- Use WebTrends plug-in cookie—If a WebTrends extended 
logging plug-in is installed on your web server, you can use the 
WebTrends cookie to track user sessions.
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-- Use this cookie—If your site uses several cookies, enter the 
cookie you use for tracking user sessions here.
For example, if you are using Microsoft SiteServer, you might 
have cookies that look like this:

SITESERVER=ID=CookieValue1;

SITESERVER=GUID=CookieValue2

If the GUID is the cookie that you want to use to identify user 
sessions, then you should enter SITESERVER=GUID here.

-- Use entire cookie field—This will include all cookies from 
your site in this profile’s analysis.

Click Next. (In Profile Edit mode, click OK to save your settings.)

31. You can edit Advanced Features from the Profile view. Click 
Configure to launch the Advanced Features dialog box. For details 
on configuring the Advanced Features, refer to the following sections:

• Content Groups (see “Content groups” on page 214)

• Path Analysis (see “Path analysis” on page 211)

• URL Parameter Analysis (“URL Parameter Analysis” on page 216)

• URL Search and Replace (“URL Search and Replace” on page 208)

• Advertising Views (see “Advertising Views” on page 220)

• Intranets (see “Intranet Configuration” on page 224)

32. Click Next to continue. 

33. The Reporting Methods dialog box opens (“Reporting Method dialog 
box” on page 27).
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 Figure 3-8.  Reporting Method dialog box

34. Select the reporting method you want to use:

• Pre-generated Reports—Reports are generated on a schedule.

• On-demand Reports—Reports are generated dynamically upon 
user request.

Note: For details on pre-generated and on-demand reports, please see 
“Pre-generated and on-demand reporting” on page 90.

Click Next to continue.

35. The Report Template dialog box opens (“Report Template dialog box” on 
page 28)
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 Figure 3-9.  Report Template dialog box

36. Report templates define the content, language, and style for the 
report. For details on report templates, see “Adding report templates” on 
page 97. Select the template you want to use from the drop-down list:

• Complete CTRS Report

• CTRS Executive Summary

• Marketing Report

• System Administrator Report

• WebMaster Report

Click Next to continue.

37. The Report Header dialog box opens (Figure 3-10). (In Profile Edit 
mode, click Edit, then select the Report Header tab.)
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 Figure 3-10.  Report Header dialog box

38.  Type or browse to set the following options:

• Report Image—Specifies which graphic to include in the report 
header.

• Report Image Alt—Specifies the text that is displayed if the 
image isn’t available or as the graphic is loading.

• Associated URL—Specifies the URL to load when a visitor clicks 
on the Report Image.

39. When you have completed your Report Header settings, click Next. 
(In Profile Edit mode, click OK to save and close the window.)

40. The Next Profile Add screen is the Reports dialog box (Figure 3-11). 
(From Profile Edit mode, click Edit, then select Report Types.)
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 Figure 3-11.  Reports dialog box

41. Select the report intervals that you want to maintain by clicking in the 
appropriate Report Types boxes. 

42. For each report type, specify the number of reports to save from the 
corresponding Reports to Store list.

Note: If you run a large number of reports, you might limit the number of 
reports that are saved. Using this option, you can select the number of 
reports saved for each interval. For example, you might want to keep one 
month’s worth of daily reports at a time; once the report for February 1 is 
created, the report for January 1 is deleted, and so on. When determining 
how many reports to store, consider how much disk space you want 
to devote to reports and how long you want to save them. A report 
using the Complete Summary template as it was installed needs 1 
MB.
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43. Click Next. (In Profile Edit mode, click OK to save your changes).

44. The next Profile Add screen is the Memory Usage dialog box (Figure 
3-12).

 Figure 3-12.  Memory Usage dialog box

45. Optional: If you want to limit the sizes of the following tables, enter the 
limiting number in the Visitor Tracking, Top Companies, Top 
Documents, and Top Forms text boxes. 

Here is an example of what happens when you put a limit on an 
internal table, using Top Companies as an example. If the Top 
Companies limit is set to 10,000, then RS will track the first 10,000 
organizations visiting your web site. After the first 10,000 
organizations have been put into the internal table, no new 
organizations will be added to the table. However, activity by 
organizations already in the table will continue to be tracked.
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Limiting Top Companies is usually the first option. This table typically 
uses more memory than all tables except Visitor Tracking. Limiting 
Top Companies affects only the "Most Active Organizations" section 
of the report.

Limiting Visitor Tracking is usually the second option. Tracking visitors 
is important enough that RS includes a low memory usage method of 
tracking visitors. The low memory usage method will track who has 
visited your site and how many times they have visited, but will not 
track things like exactly when the visits occurred, how long they 
lasted, how many pages were viewed in each visit, etc.

For most sites, limiting Top Documents and Top Forms should not be 
necessary. If large amounts of memory are being used by these 
tables, other avenues should be explored before limiting the tables 
sizes. This includes looking at the definitions for document types, 
looking at extensions that are excluded from being treated as forms, 
and using URL Search & Replace to remove dynamic content that is 
not contributing useful information to the report.

46. The next Profile Add screen is the Report Scheduler dialog box 
(Figure 3-13 on page 33).
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 Figure 3-13.  Report Scheduler dialog box

47. In the Initial Start Time field, specify when you want reports to begin.

48. Select how often to update the report from the Interval drop-down list.

49. Click Next. (In Profile Edit mode, click OK to save your changes.)

Pre- and post-processing

50. The Pre-processing dialog box opens (Figure 3-14 on page 34).
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 Figure 3-14.  Pre-processing dialog box

51. Use the pre-processing feature to run a file immediately prior to a 
scheduled analysis. You can configure the Reporting Server to not 
run the scheduled analysis should the pre-processing command fail. 
Pre-processing is configurable on a per-profile basis.

Select the Pre-processing checkbox if you want to have the Reporting 
Server run a file prior to analyzing this profile. 

52. Browse to the application you want to run. 

53. Enter the pathname to the working directory. 

54. Enter any command line parameters you want to use. Command-line 
options include:

• isenabled = false Use specified pre or post process command 

• application = Application to execute parameters

• parameters  = Parameters for said application [optional]
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• workingdirectory = Directory to execute application [optional]

• ignorereturncode = true Continue to processes and perform no 
comparison on return code 

• returncode = 0 Space or command delimited string of return 
codes [all success or failure]

• returncodetype = success Compare resulting return codes to 
specified return codes with '==' or '! ='. The will allthe user to have 
return codes be success or failure code. Options are success or 
failure, defaults to success.

55. You can ask the Reporting Server to consider return codes. To use 
this option, select the Check return codes radio button. Enter your 
settings, and click OK to save. (You may need to scroll down to view 
all the settings available to you.)

56. Click Next to continue.

57. The post-processing dialog box opens (Figure 3-15 on page 36).
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 Figure 3-15.  Post-processing dialog box

58. Use the post-processing feature to run a file immediately after an 
analysis. Post-processing is configurable on a per-profile basis.

Select the Post-processing checkbox if you want to have the 
Reporting Server run a file after completing this analyzing this profile.

59. Browse to the application you want to run. 

60. Enter the pathname to the working directory. 

61. Enter any command line parameters you want to use. Command-line 
options include:

• isenabled = false Use specified pre or post process command

• application = Application to execute

• parameters = Parameters for said application [optional]

• workingdirectory = Directory to execute application [optional]
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• ignorereturncode = true Continue to processes and perform no 
comparison on return code

• returncode = 0 Space or command delimited string of return 
codes [all success or failure]

• returncodetype = success Compare resulting return codes to 
specified return codes with '==' or '! ='. This will allow the user to 
have return codes be success or failure code. Options are 
success or failure, defaults to success.

• runalways = false If analysis has terminated abnormally, should 
the post-process command be performed?

62. You can ask the Reporting Server to consider return codes. To use 
this option, select the Check return codes radio button. Enter your 
settings, and click OK to save. (You may need to scroll down to view 
all the settings available to you.)

63. Click Next to continue.

Specifying a DNS lookup method

64. The next Profile Add screen is the DNS Lookup dialog box (Figure 3-
16 on page 38).
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 Figure 3-16.  DNS Lookup dialog box

65. In the Domain Name/IP Resolution mode, select one of the following 
methods:

-- Quick mode, using format from log—This is the fastest 
method for creating reports. If your web server doesn’t perform 
DNS Lookups and you select this method, reports display visitor’s 
IP addresses rather than domain names.

-- Resolve mode, lookup all numeric IPs—If your web server 
does not perform DNS Lookups and you need geographic or 
other domain-related information, select this option.

-- Auto mode, if you’re unsure—If you don’t know whether 
your log file contains IP addresses or domain names, you can let 
the Reporting Server decide. With auto-mode selected, the 
program assumes that your web server wasn’t performing DNS 
lookups, and uses Resolve Mode. Then, if a record contains a 
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domain name, it assumes that the web server was performing 
DNS lookup and switches to Quick Mode.

Note:  Resolve mode may slow reporting. Use it only if DNS lookups cannot 
be done on the server. Once a numeric address has been looked up, its text 
equivalent is stored in a permanent cache to expedite all subsequent reports. 
The default cache size is 50,000 entries; once this limit is reached, the oldest 
addresses are replaced with the new entries. You can change the cache 
size in the General Options tab. See “Defining General options” on page 
176 for details.

66. Click Next. (In Profile Edit mode, click OK to save your changes.)

Setting user access to the profile

67. The next Profile Add screen is the Profile Access dialog box (Figure 3-
17 on page 40).
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 Figure 3-17.  Profile Access dialog box

68. Giving a user access to the profile enables them to use it according to 
the rights that they have been given. 

69. The Users who have access list displays users who have access to 
this profile. The Users without access list displays users denied 
access. Use the arrows to change the list.

70. If you want the report for this profile to be viewed publicly, select the 
Enable reports generated by this profile to be viewed 
anonymously by the general public option.

71. Click Next. (In Profile Edit mode, click OK to save your changes.) The 
Summary page opens (Figure 3-18 on page 41). 
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 Figure 3-18.  Summary page

If the summary data is correct, click Finish. This profile will be added 
to the Reporting Server.

If the summary data is incorrect, click Back to change your settings. 
You can also edit this profile at a later time by selecting the profile 
from the Reporting Server main console, and clicking Edit on the 
toolbar.

Analyze Now, Re-analyze, and recovering archived data 
The functions Analyze Now, Re-analyze, and working with archives can help 
you process profile data in important ways.



WebTrends Enterprise Reporting Server

42

Analyze Now

Use Analyze Now if you need to generate reports on profiles which haven’t 
been recently analyzed. Analyze Now overrides the scheduled analysis of a 
profile, and inserts profile into report queue.

Analyze Now will: 

• Append data to the profile's database. (If space limitations demand, 
old data will be deleted to make space for new analysis data.) 

• Insert the profile into the report queue.

Please note that the profile may not be analyzed immediately, if there is 
already an analysis underway. If so, the profile will remain queued until 
analysis can begin. 

To use Analyze Now:

1. From the Main Console, select the profile you want to analyze.

2. Select Profile>Analyze Now. The Analyze Now dialog box appears 
(Figure 3-19 on page 42).

 Figure 3-19.  Analyze Now dialog box
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3. Click OK to insert the profile into the analysis and report queue.

Be aware that by using Analyze Now—thereby changing when data was 
analyzed—and editing a profile, such shifts in how reports are run may create 
changes in on-demand reports which over time show shifts in data patterns. 
You may find, upon examination of your reports, and when your profile was 
changed or analyzed, that you may need to either reanalyze a profile, or 
report on an archived profile database. Instructions on these procedures 
follow. 

Reanalyze Profile

Use Reanalyze Profile if you need to create completely new reports which 
reflect changes to profile settings. 

Reanalyze Profile will: 

• Delete all databases and reports associated with the old version of 
the profile. 

• Does not change profile settings (.wlp, .wdw, etc.) or profile statuslog. 

• Create new databases from this point forward based on new profile 
settings. 

• Inserts profile into report queue. 

Please note that the profile may not be analyzed immediately, if there is 
already an analysis underway. If so, the profile will remain queued until 
analysis can begin.

To use Re-analyze Profile, complete these steps:

1. From the Main Console, select the profile you want to reanalyze.

2. Select Profile>Re-analyze. The Re-analyze Profile dialog box 
appears (Figure 3-19 on page 42).
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 Figure 3-20.  Re-analyze Profile dialog box

3. Click OK to reanalyze the profile.

Activating archiving

You can archive the profiles that you chose at regular intervals. An archive 
contains a backup of the databases for the profile. Archiving allows you to 
restore a profile to a point in the past. Archives are useful if some log files 
were not available during analysis, if you discover your log files have been 
corrupted, or if you made changes to the profile that you want to restore.

• Archive settings are maintained in the Options window.

• See “Restoring profiles to an earlier state” on page 45 for details on using 
archives.

To enable archiving:

1. Select the profile to work with, and click Edit.

2. Select the General tab.

Click in the Enable Archiving box. The archive is made at regular intervals 
which have been defined in the Options window.
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Restoring profiles to an earlier state

Profiles that have been archived can be restored to one of the archived 
versions. For example, if the wtrs.audit file says that there is a date without 
log file data, you could restore the profile to an earlier version using an 
archive, place the missing logs in the proper location, and restart the analysis 
so that reports show activity for the newly added logs files.

Monitor the wtrs.audit file for messages like this one to determine when an 
archive should be used:

Sep-07-1999 07:33:48: No log data for profile daily on 
Sunday, February 14, 1999

 Figure 3-21.  Profile Archives dialog box.

To restore an archive:

1. Select the profile to restore.

2. Select Profile>Archives. The Profile Archives dialog box opens (Figure 
3-21). 

3. Select the archive that you want to use from the drop-down Available 
Archives list, and click Restore.

Important: When you restore a profile using an archive, all databases and 
reports created after the archive date are deleted.
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Specifying a schedule for reporting
Use the Report Scheduler dialog box to specify when the profile is analyzed 
and how often reports are updated.

If the program Administrators have chosen, new profiles can be analyzed 
immediately once they are created. If this is the case, the Reports Scheduler 
dialog box says that the "Start Immediately" option has been selected. In this 
case, the time and interval that you specify here determines all subsequent 
analyses.

1. Select the profile to work with, and click Edit.

2. Select the Scheduler tab. In the Base Time field, specify when you 
want reports to begin. 

3. Using the Interval drop-down list, select how often to update the 
report.

 Figure 3-22.  Scheduler tab

Specifying the location for reports
The Reporting Server can be configured by the Administrator to use either the 
built-in web server or an alternate web server for posting reports. If the 
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program has been configured to use an alternate web server and the location 
can be defined at the profile level, you can use the Report Paths dialog box to 
specify the location and URL where the reports for this profile are posted.

Note:  If you change the directory where reports are stored, only new reports 
appear in this directory. Reports created before the change remain in the original 
directory.

To specify where the reports will be generated, complete these steps:

1. Select the profile to work with, and click Edit.

2. Select the Report Paths dialog box. By default, the location of the 
built-in web server is displayed. 

3. In the Report Directory field, specify the location where reports for this 
profile are saved.

4. In the Report URL Path, specify the URL where users can view the 
report for this profile.
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 Figure 3-23.  Report Paths tab

Specifying the database directory
If accessible, use the Report Database dialog box to specify the location 
where the profile database should be saved. These databases store all the 
information needed to create reports, and because of this, they can grow 
quite large. For this reason, you should place these directories on a drive 
where you have a large amount of available space.

Note:  If you change the database location, the Reporting Server reanalyzes the 
log file from the beginning. This is because a new database is created, and the 
original databases remain in the old location.
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To specify a database location, complete these steps:

1. Select the profile to work with, and click Edit.

2. Select the Report Database tab (Figure 3-24).

 Figure 3-24.  Report Database tab

3. Enter the file path where you want to store the profile database. To 
maintain separate databases for each profile, use the %PROFILE% 
macro; the profile name is used in the directory name. 

Selecting URL Search and Replace definitions
URL Search and Replace settings are defined in the Advanced features 
window. URL Search and Replace definitions can either be applied to all 
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profiles or applied to individual profiles. If the option to select definitions for 
each profile is enabled, the Advanced Features dialog box is accessible when 
you work with profiles. 

URL replacement definitions delete specific identifiers from URLs or replace 
all unique identifiers with a common string. View the settings for the definition 
to see how it functions.

See “URL search and replace definitions” on page 203 for more information on 
using this feature.

To specify the URL replacement definitions:

1. Select a profile to work with, and click Edit.

2. Select the Advanced Features tab. Click Configure.

3. Select the URL Replacement tab to view a list of definitions.

4. Select a definition, and click View to view its settings.

5. Click in the check boxes to select the definitions to use.

Selecting URL Parameter Analysis definitions
URL Parameter Analysis settings are defined in the Advanced Features 
window. URL Parameter Analysis definitions can either be applied to all 
profiles or applied to individual profiles. If the option to choose URL 
Parameter definitions for each profile is enabled, the Advanced Features tab 
is accessible in the profile window.

URL Parameter Analysis definitions associate a page with the parameter 
used to create it, allowing you to report on dynamically created web pages.

See “Configuring web server settings” on page 201 for more information on using 
this feature.

To specify URL parameter analysis definitions:

1. Select a profile to work with, and click Edit.

2. Select the Advanced Features tab. Click Configure.

3. Select the URL Parameter Analysis tab to view a list of definitions.

4. Select a definition, and click View to view its settings.

5. Click in the check boxes to select the definitions to use.
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Selecting Content Group definitions
Content Group settings are defined in the Advanced Features window. 
Content Group definitions can either be applied to all profiles or applied to 
individual profiles. If the option to choose Content Group definitions for each 
profile is enabled, the Advanced Features tab is accessible in the profile 
window.

Content Groups allow you to group related pages together in one report. The 
Content Group definition is a set of patterns that identifies the pages that you 
want to report on as a group. See “Configuring web server settings” on page 201 
for more on this feature.

To specify content group definitions:

1. Select a profile to work with, and click Edit.

2. Select the Advanced Features tab, and click Configure.

3. Select the Content Group tab to view a list of definitions.

4. Select a definition, and click View to view its settings.

5. Click in the check boxes to select the definitions to use.

Selecting Path Analysis definitions
Path Analysis settings are defined in the Advanced Features window. Path 
Analysis definitions can either be applied to all profiles or applied on a profile 
basis. If the option to choose Path Analysis definitions for each profile is 
enabled, the Advanced Features dialog box is accessible in the profile 
window.

A Path Analysis definition specifies the page and the number of paths that you 
want to track. See “URL Search and Replace” on page 208 for a detailed 
explanation.

To specify path analysis definitions:

1. Select a profile to work with, and click Edit.

2. Select the Advanced Features tab. Click Configure.

3. Select the Path Analysis tab to view a list of definitions.

4. Select a definition, and click View to view its settings.
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5. Click in the check boxes to select the definitions to use.

Copying a Profile
You can use existing profiles as the basis for a profile using the Copy Profile 
command.

1. Select a profile in the list, and select File>Profile>Copy Profile from 
the Profile menu. A copy of the profile opens.

2. Rename the profile, and make any modifications. 

3. Once you have made changes, click OK to close the window.

Editing a Profile
Use the Edit Profile dialog box to modify settings for a profile. If the profile is 
being used for analysis when you make changes, it is updated when the analysis is 
complete.

1. Select a profile in the list, and click the Edit button. 

2. Select the tab with the settings that you want to modify. 

3. Once you have made your changes, click OK to close the window.

Deleting a Profile
You can remove profiles from the Profile List if they are no longer needed.

1. Select a profile in the list, and click the Delete button. 

2. Click OK to confirm that you want to remove the profile.

Stopping Analysis
You can interrupt processing of a profile using the Stop Analysis/Reporting 
command. Doing so postpones analysis until the next scheduled interval.

1. Select the profile whose processing you want to stop.

2. Select Profile>Stop Current Cycle. The Stop Current Analysis/
Reporting Cycle window opens (Figure ).



 Chapter 3: Using Profiles

53

 Figure 3-25.  Stop Current Analysis/Reporting Cycle window

3. Click Ok to stop the processing of the profile.

Monitoring profile status
The Reporting Server maintains a status file for each profile which you can 
use to monitor the processing of the logs. From the Profile Status window you 
can view the current state of the profile, the file name and location of the 
status log file. Use the scroll bar to peruse the profile history.

To access the profile status:

1. Select the profile you want to monitor from the Main Console.

2. Select View>Profile Status. The Profile Status dialog box opens 
(Figure 3-26 on page 54).
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 Figure 3-26.  Profile status window

Changing the profiles displayed in the main console
If your profile library has grown to the point that finding the profile to work with 
has become a chore, you can limit the number of profiles that are displayed 
through the main console. Or, if you know the name or part of the name of the 
profile you are looking for, you can search for it here.

Tip: You can increase the number of profiles displayed by modifying the 
MaxGridProfiles option in the wtm_wtx.ini file
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. 

 Figure 3-27.  Profile search window

To filter the profiles displayed:

1. Select File>Search. The Profile search window opens.

2. Limit the profiles displayed using the following criteria:

• User—Allows you to display only profiles for the user specified.

• Description—Allows you to view profiles whose description 
matches your criterion.

Note:  To view the maximum number of profiles allowed, enter * in both 
fields.
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4
How they work

Filters let you limit the scope of your analysis and the data by specifying the 
data you are interested in. The result of the analysis determines what is 
displayed in your reports. This release of the Reporting Server includes new 
filtering capabilities: you can filter by visits or hits, and you can now filter on 
cookies as well as URL parameters.

Important: If you have been granted administrative rights, you can add, edit, and 
modify all profiles, even those created by other users. If you have not been granted 
administrative rights, many of the options explained in this chapter may not be 
available to you.

How filters are processed
You can set up the following types of Include or Exclude filters:

• Filter visits by

– Entry Page

– Referrer

For instructions on building visit filters, see See “Adding an Include or 
Exclude Visit Filter” on page 58 below.

• Filter hits by the following parameters:

– URL

– Directory

– File

– Browser

– Cookie

– Multi-homed domain

– Day of Week

– Hour of Day

– Authenticated Username

Using Filters 4
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– Return Codes

– Ad Views and Clicks

– HTTP Methods

• Address

Adding an Include or Exclude Visit Filter
You can add visit filters to any profile.

To add a Visit Filter to an existing profile:

1. From the Reporting Server Main Console, select the profile that you 
want to filter, and click Edit. The Profile Edit window opens.

2. Select the Filters tab. The Filters dialog box opens (Figure Figure 4-28 
on page 59).
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 Figure 4-28.  Filters dialog box

3. You can add either Visit or Hit filters at this window.

Note: You can return to this screen to add or edit additional filters.

• To add a Visit Filter, click Add beneath the Visit Filters text box. The 
Filter Type dialog box opens (“Filter Type dialog box” on page 60).
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 Figure 4-29.  Filter Type dialog box

4. Select the type of filter you want to create:

• Include Filter—only log data which matches this criteria will be 
included in Reporting Server reports for this profile.

• Exclude Filter—log data which matches this criteria will be 
excluded from Reporting Server reports for this profile.

Click Next to continue. The Filter Name dialog box opens (Figure 4-30 
on page 61).
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 Figure 4-30.  Filter name dialog box

5. Enter the name you want to identify the filter with in the Filter Name 
text box.

6. Select one of the following options:

• Include/Exclude all activity—include all visits in this profile’s 
report.

• Include/Exclude activity based upon—limit the visits included 
in this profile’s report to the selected Active Visit Filter 
Parameters. Select from the following Active Visit Filter 
Parameters to build your filter:

– Entry Page

– Referrer
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7. Click Next to continue. 

8. If you selected Include/Exclude all activity, go to step Step 16 to 
complete building your filter.

9. If you selected Include/Exclude activity based on, continue with 
one of the following paths:

• If you selected Entry Page, the Entry Page dialog box opens 
(Figure 4-31). Continue with Step 10.

• If you selected Referrer, the Referrer dialog box opens (Figure 4-
32 on page 64). Continue with Step 13.

 Figure 4-31.  Entry page dialog box

10. Use the Entry Page parameter to include visits based upon the page 
at which they entered your site. Enter an expression that describes 
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the entry page(s) in the Page Expression text box. You may use 
asterisks(*) as wildcards.

11. Select the Regular Expression check box if you want to use regular 
expressions. Click Test to verify your entry before continuing.

Note: Click the Help button on this page for examples of page 
expressions.

12. If you want to filter on URL Parameters, select one of the following 
options:

• To add an URL parameter:

a) Click Add to add an URL parameter. The URL Parameter 
page opens.

b) Enter your settings, and click OK to continue.

• To edit an existing URL parameter:

a) Select the parameter you want to edit.

b) Click Edit. The URL Parameter page opens.

c) Enter your changes, and click OK to continue.

• To delete an existing URL parameter:

a) Select the parameter you want to delete.

b) Click Delete. The URL parameter is removed from the list.

Click Next to continue. Continue with Step 16.
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 Figure 4-32.  Referrer dialog box

13. Select which type of referrers you want to either include in or exclude 
from your filtering from the Referrer drop-down list. Choose from:

• All Referrers

• No Referrer

• http: URLs

• file: URLs

• mail: URLs

• ftp: URLs

• User Defined Referrer

The default setting is All Referrers.
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14. Unless you have selected All Referrers or No Referrers, enter the 
URL in the Referral text box. 

Note: Click the Help button on this page for examples of referring URLs.

15. Click Next. Continue with Step 16. 

16. The Summary page opens (Figure 4-33 on page 65). The details of your 
current filter settings are displayed. Click Back to edit your settings, 
or Finish to complete building your filter.

 Figure 4-33.  Summary page

Adding an Include or Exclude Hit Filter
You can add hit filters to any profile.



WebTrends Enterprise Reporting Server

66

To add a hit filter to an existing profile:

1. From the Reporting Server Main Console, select the profile that you 
want to filter, and click Edit. The Profile Edit window opens.

2. Select the Filters tab. The Filters dialog box opens (Figure Figure 4-28 
on page 59).

 Figure 4-34.  Filters dialog box

3. You can add either Visit or Hit filters at this window. To add a hit filter, 
click Add beneath the Hit Filters text box. The Filter Type dialog box 
opens (Figure 4-35 on page 67).

Note: You can return to this screen to add or edit additional filters.
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 Figure 4-35.  Filter Type dialog box

4. Select the type of filter you want to create:

• Include Filter—only log data which matches this criteria will be 
included in Reporting Server reports for this profile.

• Exclude Filter—log data which matches this criteria will be 
excluded from Reporting Server reports for this profile.

Click Next to continue. The Filter Name dialog box opens (Figure 4-36 
on page 68).
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 Figure 4-36.  Filter name dialog box

5. Enter the name you want to identify the filter with in the Filter Name 
text box.

6. Select one of the following options:

• Include/Exclude all activity—include all visits in this profile’s 
report.

• Include/Exclude activity based upon—limit the visits included 
in this profile’s report to the selected Active Hit Filter Parameters. 
Select from the following to build your filter:

– URL

– Directory

– File

– Browser
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– Cookie

– Multi-homed domain

– Day of Week

– Hour of Day

– Authenticated Username

– Return Codes

– Ad Views and Clicks

– HTTP Methods

– Address

Note: For full descriptions of these visit parameters, see “Filter 
Parameter Descriptions” on page 73.

7. Click Next to continue.

8. If you selected Include/Exclude all activity, go to step Step 16 to 
complete building your filter.

9. If you selected Include/Exclude activity based on, the wizard opens 
one dialog box for each parameter you selected. Enter your settings 
on each page, clicking Next to continue.

Note: You can click Back at any time during this sequence to make 
changes to the hit filter you are building.

10. The Summary page opens (Figure 4-37 on page 70). The details of your 
current filter settings are displayed. Click Back to edit your settings, 
or Finish to complete building your filter.
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 Figure 4-37.  Summary page

Editing a Filter 

To edit a filter, complete these steps:

1. From the Reporting Server Main Console, select the profile 
containing the filter you want to edit, and click Edit. The Profile Edit 
window opens.

2. Select the Filters tab. The Filters dialog box opens (Figure Figure 4-38 
on page 71).
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 Figure 4-38.  Filters dialog box

3. Select the filter you want to edit from either the Visit Filters or Hit 
Filters text box. Click Edit.

4. The Filter Wizard opens. Make your changes, and click OK to save 
your settings. The updated filters are now active in the profile. 

Note: Reports generated on this profile will not reflect these updated 
filter settings until the next analysis.
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Deleting a filter

To delete a filter, complete these steps:

1. From the Reporting Server Main Console, select the profile 
containing the filter you want to delete, and click Edit. The Profile Edit 
window opens.

2. Select the Filters tab. The Filters dialog box opens (Figure Figure 4-38 
on page 71).

 Figure 4-39.  Filters dialog box

3. Select the filter you want to delete from either the Visit Filters or Hit 
Filters text box. Click Delete.
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The filter is removed from the profile.

Filter Parameter Descriptions

Visit Filter Parameters

Entry Page

Use the Entry Page filter element to include or exclude entire visitor sessions 
based upon the first page viewed. An entry page is the first item that the 
visitor requests in a session. The item could be an image, a document, or a 
file.

For example, you have an ad banner on Yahoo! that links users to the page /
ads/yahoo_ad.htm. (This page might simply redirect users to your home 
page.) You could create an Include filter with the entry page element set to /
ads/yahoo_ad.htm to determine the number of users clicking through from 
that banner. 

The following table provides examples of how to format an Entry Page filter. 
Keep in mind that the Entry Page filter filters entire user sessions, not 
individual hits.

Table 4-1. Entry Page filter examples

You can also use wildcards to match strings. For example, if the filter string 
contains no file or extension, and has exactly one asterisk (*), which appears 
at the end of the string, a string match against the record path is performed.

Example Explanation 

/browser.htm Filters any session starting at browser.htm in the root 
directory. 

browser.htm Filters a session browser.htm from any directory.

/ads/*.htm Filters any .htm file in the /ads directory.

/ads/*.* Filters any file in the /ads directory.

ad.* Filters any file named ad from any directory.
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Referrer

Use the Referrer filter to include or exclude entire user sessions based on the 
referring URL. A referring URL is the link that the user came from. This filter 
helps you identify the quantity and quality of users coming to your site from 
other sites or from a specific Internet advertisement.

Whereas other filters deal with hits, the referrer filter deals with user sessions 
to determine where your users are coming from. A typical user session is 30 
minutes.

The default for the Referrer Include filter, All referrers, filters all hits with 
referring data regardless of site.

The default for the Referrer Exclude filter, No referrers, filters only hits 
without any referring information.

A filter entry of http:// filters any hits prefixed by http://.

Table 4-2. Examples of search engine filters

Example Explanation

http://
www.referrer.com*

Filters anything coming from http://
www.referrer.com. Hits from ftp://www.referrer.com 
are not filtered. 

http://www.referrer.* Filters www.referrer.com, www.referrer.net, 
www.referrer.org.

*.referrer.com* Filters ftp.referrer.com, www.referrer.com, but not 
things such as www.referrer2.com or 
www.referrer.net. 

*referrer* Filters anything with referrer in the name. 
www.referrer.com, www.referrer1.com, 
www.notreferrer.net, referrer.com, referrer, etc. 

http://
www.referrer.com/
page.htm

Filters only references from page.htm at the 
www.referrer.com site. 

http://
www.referrer.com/
page.htm*

Filters page.htm, page.html, page.html2, etc. from 
the root of the www.referrer.com domain. 

*.referrer.com/
page.htm*

Filters page.htm or page.html from any 
referrer.com domain (such as search.referrer.com 
or ftp.referrer.com).
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Hit Filter Parameters

Directory or URL

Use the Directory filter to include or exclude the activity of a specific directory. 
The default for an Include Directory filter is to include all directories starting at 
the root directory, indicated by a slash (/). There is no default for the Exclude 
Directory filter. 

If you want to include or exclude all subdirectories starting with the directory 
you specify and proceeding down, select the Include/Exclude 
Subdirectories check box. Select the Case Sensitive check box if you want 
to look for exact case matches.

Note: Because most servers require case-sensitive (upper or lower case) 
matches, be careful to specify the exact case you want to look for, and check the 
Case Sensitive box.

The default for both include and exclude files filters is to activate the 
subdirectories box (indicated by a check in the Include/Exclude 
Subdirectories box). Therefore, if you created an Exclude filter for the                     
/Images directory, the subdirectories are automatically excluded. Or if you 
create an Include filter for a directory, the subdirectories are automatically 
included in the filter.

Use wildcards to specify multiple directories, or separate directories with a 
space. Put quotation marks around directories containing spaces or commas. 
For example: "/logo graphic"

Table 4-3.  Directory Filter examples

Example Result

/images Specifies the directory /images is filtered and all 
subdirectories therein, if Include Subdirectories is 
checked.

"/image files" Specifies the long directory, /image files.

"/image files" /
intranet /graphics

Specifies the following directories: /image files, /intranet, 
and /graphics.

/*graphics Specifies any first-level directory whose name ends in 
graphics, such as /bitmap graphics, but not /intranet/
bitmap graphics.
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File

Use the File filter to include or exclude specific files. Enter the file name or 
extension in this field, or click the down-arrow to select a file type from the list. 
The default for an Include File filter is to include all files, indicated by “*.*”. 
There is no default for an Exclude File filter.

Use wildcards to specify file names or extensions, such as all HTML files 
(*.HTM) or all GIF files (*.GIF). Specify several file types at once by inserting a 
space between each file type.

A check in the Case Sensitive box means that you want to look for exact case 
matches (upper or lower case). 

Note:  Many servers are case-sensitive, be sure to enter your filter exactly as 
what you want to look for in the log file, and check the Case Sensitive box.

Table 4-4.  File Filter examples
  

/*/graphics Specifies all second-level directories named /graphics, 
such as /home/graphics and /intranet/graphics, but not /
home/sales/graphics. Directories such as /home/
graphics/logos, are specified by this example only if 
Include Subdirectories is checked. 

/graphics /*/
graphics /*/*/
graphics

Specifies all first, second and third level directories 
named graphics, such as /graphics, /home/graphics, and 
/home/sales/graphics. Subdirectories of these, such as /
home/graphics/logos, and /home/sales/graphics/logos/
specials would be included only if Include Subdirectories 
is checked.

/*graphics*/ Specifies all first level directories with names containing 
graphics, such as /graphics, /graphics files, and /bitmap 
graphics.

Note: Remember to put quotation marks around 
directories containing spaces or commas.

Example Result

help.htm Filters the file help.htm.

*.gif *.bmp Filters bitmap (.bmp) and gif (.gif) files.

Example Result
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Browser
Use the Browser filter to either include or exclude a browser, spider or robot 
from the analysis and reporting. You can filter any browser if you know how it 
appears in the Agent field of the log file.

Use a space to separate multiple browsers. Put quotation marks around 
browser names that have spaces. You cannot use wildcards for browser 
filters.

Table 4-5.  Browser filter examples 
 

Note:  You cannot use wildcards (*) in a browser filter. Webhouse Builder 
assumes that there are wildcards at either end of each browser entry when 
comparing it to the agent field in the log file. 

Filtering for Netscape Navigator may not return accurate results because many 
browsers identify themselves as Netscape Navigator.

Cookie
A cookie is a file sent with the page requested from the server to the visitor, 
and stored on the visitor’s system. It uniquely identifies previous visitors to 

help*.html Filters all html files whose name begin with help.

help*.* Filters all files whose name begin with help, regardless of 
type.

marketing.htm  
"marketing 
help.htm"  
"marketing 
leads.htm"

Filters the files marketing.htm, marketing help.htm, and 
marketing leads.htm. 

Example Result

Mozilla/4. Mozilla/3.1 Filters any activity that matches Netscape Navigator 
4. or Netscape Navigator 3.1.

MSIE “Microsoft 
Internet Explorer/”

Filters any activity that matches any version of 
Internet Explorer.

Example Result
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your site the next time they return. The cookie filter is a session filter-when the 
cookie for a visitor session is matched or not matched, depending on whether 
the filter is include or exclude-the entire visitor session is included or 
excluded. You can use regular expressions in building this filter.

Multi-homed domain
Use the Multi-Homed Domain filter if your log file contains activity from more 
than one domain. Specify the domains you want to include or exclude. For 
example, if your log file contains activity from domains www.abc.com, 
www.def.com, and www.ghi.com, and you want to store activity for 
www.abc.com, you would create an Include file and enter www.abc.com.

Notes: This filter only applies to multi-homed log files.

To filter multiple domains, separate your entries with a space. 

Day of Week
Use the Day filter to include or exclude specific days of the week. For 
example, if you create an Include Days filter, a check indicates the log file 
activity must match the days specified in order to stored in the database.

Hour of Day
Use the Hour filter to include or exclude hours of the day. The default for the 
Hour Include filter is All. The default for the Hour Exclude filter is None.

Any activity that is within the hour range that you specify through the 
Between...And range is filtered.

Note:  Enter the hours in military format (twenty-four hour clock).

Table 4-6.  Hour filter examples 
   

Example Result

Between 12 and 17 Filters any activity that took place between 12 p.m. to 5 
p.m.

Between 20 and 6 Filters any activity that took place between 8 p.m. to 6 
a.m.
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Authenticated Username
If you have an intranet site or a web site that requires visitors to log on with a 
user name and password, then you can use the Authenticated User name 
filter to include or exclude authenticated users from this profile.

Enter the name that you want to filter for. Put quotation marks around names 
that contain spaces. Refer to the examples that follow for formatting tips. 
Check the Case Sensitive box if you want to look for exact case matches. 

Note: Because most servers are case sensitive, be sure to enter your filter 
exactly as the data appears in the log file, and check this box.

Table 4-7.  Authenticated User Name filter examples 
   

Return Codes
Use the Return Code filter to specify the types of results you want to include 
or exclude. For example, if you are creating an include filter and you want to 
only report on successful hits, select Success Only from the list.

You can select one of the common returns codes provided in the list, or type 
another numeric result code in this field.

Note: Note: The default, All Return Values, is indicted by an asterisk (*) in the 
field.

The predefined list includes the following: 

• (All Return Code) 

• Success Only 

Example Result

"Jane Smith" Filters any activity that matches Jane Smith.

Note: If the user name you are filtering contains a space, 
use quotation marks around the user name as shown 
here.

"Bob Smith" "Mike 
Macintosh" "John 
Hill"

Filters any activity that matches these user names.
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• Failed Only 

• Success, OK (200) 

• Success, Created (201) 

• Success, Accepted (202) 

• Success, Partial Information (203) 

• Success, No Response (204) 

• Success, Redirected (300) 

• Success, Moved (301) 

• Success, Found (302) 

• Success, New Method (303) 

• Success, Not Modified (304) 

• Failed, Bad Request (400) 

• Failed, Unauthorized (401) 

• Failed, Payment Required (402) 

• Failed, Forbidden (403) 

• Failed, Not Found (404) 

• Failed, Internal Error (500) 

• Failed, Not Implemented (501) 

• Failed, Overloaded Temporarily (502) 

• Failed, Gateway Timeout (503)

Ad Views and Clicks
This filter lets you produce reports based on a specific Web site 
advertisement's activity to distribute to a client. If you want to track activity 
related to a specific advertisement on your site, for example, you can define 
the ad using the ad views and clicks tool, and then filter all activities related to 
the ad.

HTTP Methods
Select which HTTP methods you want to include in your Include or Exclude 
filter: 
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• GET 

• POST 

• PUT 

• HEAD 

• UNKNOWN

Address
Use the User Address filter to include or exclude hits coming from specific 
domains, subnets, or IP addresses from the results of this profile. For 
example, you can create a filter that excludes all activity from your own 
domain. The default, All User Addresses, is indicated by an asterisk (*) in 
the field.
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5
Reports and Profiles

Reporting Server reports are based on Profiles (covered in “Using Profiles” on 
page 15.) Profiles define the data to be gathered, while the report settings 
covered in this chapter determine how this data is presented, including the 
colors, fonts, format and storage location for reports. 

You create reports in the Reporting Server using profiles that you’ve created.   
The Reporting Methods profile settings determine whether reports are 
generated at the time the profile is processed and posted for users to view 
(pre-generated) or if they are generated as users request them (on-demand). 

You can build Reports can be viewed through Netscape Navigator or 
Microsoft Internet Explorer. 

Additional configuration options for administrators—including editing report 
templates—can be found in “Configuring Program Options” on page 173 .

Important: If you have been granted administrative rights, you can add, edit, and 
modify all profiles, even those created by other users.  If you have not been 
granted administrative rights, many of the options explained in this chapter may not 
be available to you.

This chapter includes:

• “How reports are built” on page 84 

Includes a step-by-step example of creating a report using a sample 
profile with Campaign Analysis settings.

• “Pre-generated and on-demand reporting” on page 90

A discussion of the two types of reports you can build.

• Navigating reports and profiles, page 93 to page 95. 

Efficiency tips for working with past reports and profiles, as well as 
viewing profile histories.

• “Working with Report Templates” on page 97

Building Reports 5
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Customizing reports, creating new templates, changing report colors and 
styles.

• “Report data and Help Cards” on page 102

Information on updated and new Reporting Server reports.

Note: If you are already familiar with the Reporting Server and would like more 
in-depth instructions on how to creating profiles, see “Using Profiles” on page 15. 

 For information on creating Campaign Analysis definitions, see “Campaign 
Analysis” on page 63.

How reports are built 

Understanding these main concepts, and how they interrelate, is essential to 
using the Reporting Server effectively.

How Reporting Server works
The Reporting Server uses the log file from your web server to analyze 
activity on your site. Through a profile, you specify the location of the log file, 
how it should be analyzed, and the reports to generate. See “Understanding log 
files” on page 84 for details on log files.

 Figure 1-1.   Report generation process overview

By applying Campaign Analysis definitions to your Web Traffic Analysis 
profiles, you can include information on products and marketing campaigns in 
your reports.

Understanding log files
When someone connects to your site, the event is stored by the web server in 
a log file. Log files record data such as the user, the protocol used to access 
the page (such as HTTP or FTP), what they did, the platform used (such as 
UNIX, NT, Windows 98), the search engine (such as Yahoo or Lycos), 
keywords, date and time, and much more. The Reporting Server uses the 
data from this log file to create reports.

Log files typically have a .log extension and are located in various directories, 
depending on the web server that you use.

• (NT) Microsoft IIS—c:\winnt\system32\logfiles\ex981029.log
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• (NT) Netscape—c:\netscap\servers\http-[server 
name]\logs\ex981029.log

Sample Log File: Common and Combined (Extended) Format

The NCSA recognizes two log file format standards--the common and 
combined (extended) formats. The following is a sample line from a 
"common" log file:

www.webtrends.com - [16/Jan/1999:10:36:09+0000]  "GET /dept/
argguides/dwsg/420102.jpg HTTP/1.0" 304 21342

The "combined" or "extended" log file format is similar to the common log file 
format with the addition of the referrer and agent fields at the end of the line in 
quotation marks. The following is a sample in combined format

www.club-voile.fr - - [12/Jan/1996:19:35:39 +0000] "GET / 
HTTP/1.0" 200 6054 "http://search.yahoo.com/bin/
search?p=trends%20internet" "SPRY_Mosaic/v8.32 (Windows 16-
bit) SPRY_package/v4.00" 

In this example, the referrer is http://search.yahoo.com/bin/
search?p=trends%20internet, the agent is SPRY_Mosaic/v8.32, and the 
platform is Windows 16-bit.

The following table defines each of the fields in the sample log file lines.

Table 1-1.   Field definitions for sample log file

Field # Field Name Description

Field 1 User Address The numeric IP address or domain name of the 
user accessing the site.

Field 2 Rfc931 This field is used to log the domain for multi-
homed web servers.

Field 3 User Authentication User name, if required.

Field 4 Date/Time The date and time the user accessed the site.

Field 5 GMT offset The number of hours from GMT (if this is +0000 
it is logged in GMT time).

Field 6 Action The particular operation (i.e., “Get” or “Post”) of 
the hit (this must be in quotes).

Field 7 Return Code The return code for the action tells whether it 
was successful and why.
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Understanding profiles
Profiles specify how the log file should be analyzed and which activity you 
want to report on. Through the profile you define the location and log file type, 
any activity you want filtered, and whether or not IP resolution should be 
performed. Reporting Server analyzes the log file and uses the result to 
create reports. Profiles are covered in “Using Profiles” on page 15.

Understanding Campaign Analysis definitions
Campaign Analysis analysis and reports are based on two definitions that can 
be applied to any Web Traffic Analysis profile. They are explained briefly 
below:

• Product definitions are set up to track the forecasted revenue that 
specific product pages on your web site will potentially generate. In 
the context of a product definition, "product" loosely describes any 
product that you may be selling, an idea that is worth something to 
your company, an intellectual product, etc.

• Marketing campaign definitions are set up to define your marketing 
campaign information. This information includes referrer or entry 
pages, cost and duration of the campaign, an image to represent it, 
etc.

Setting up the Reporting Server
New to the Reporting Server? Use this section to get a sense of the steps 
involved in taking the product from a CD-ROM sitting in your drive to running 
reports.

Field 8 Size The size of the file sent.

Field 9 Referrer: The URL which linked the user to your site.

Field 10 Browser/

Platform

The Web browser and platform used by the 
visitor to your site.

Field # Field Name Description
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Build a Report
For This Step Refer To

1. Install the software. “Installing and Setting Up” on page 21.

2. Review the sample profile. The 
content of a profile are the key to 
successful reporting. Profiles identify the 
web server log file type, the location of the 
log file, how the data should be analyzed, 
and the reports you want to create.
Make note of the dialogs you may want to 
disable for non-administrators. You may 
want to give the responsibility of creating 
and maintaining profiles to Administrators 
only, making non-administrators’ lives 
much easier; all they’ll need to do is log in 
and select their reports.

“Using Profiles” on page 15

3. Run a Complete Summary report on 
the sample profile. 
Make note of any tables you want to 
exclude, or those you’d like more or less 
information. Later you can reflect these 
changes in the profile. 

Consider the color scheme of the style 
used in the report. You can change the 
colors for the Report Template in the 
Template dialog.

“On-demand reports” on page 92

4. Create profiles for the web server logs 
you want to analyze. If you are providing 
customized reports for different users, you 
will create a profile for each. Tell your 
users where they can view reports.

“Using Profiles” on page 15

5. Review the Options settings. Many 
default settings for profiles are located 
here. Decide whether you want non-
administrators to have access to the 
optional dialogs. 

“Defining General options” on 
page 176
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To run the Reporting Server through the remote interface, the analysis engine 
and the remote interface must be started.

Note: You can also control all aspects of the Reporting Server from the 
command line. See “Running from the Command Line” on page 123 for details.

Complete these steps to create a sample report:

1. Enter the path to the installation directory and type
wtrs

The program starts.

2. Type
wtrs -start

The Reporting Server analysis engine starts. 

3. Type

wtinterface -start

And the remote interface for the Reporting Server starts.

4. Open your web browser (Netscape Navigator or Internet Explorer). 

5. Enter the IP Address or domain name for the machine where the 
Reporting Server is installed followed by the port specified during 
installation. For example, http://192.168.0.5:99. The Login 
window opens:

6. Create user accounts for anyone who 
is going to use the Reporting Server for 
viewing reports or managing any aspect of 
the program. For each user, determine the 
permissions you want to give.

“Creating a user account” on 
page 229.

7. Modify the Report Templates or create 
your own if needed.

“Working with Report Templates” on 
page 97.

For This Step Refer To
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 Figure 5-40.  Enterprise Reporting Server login window

6. Click the Login button.

7. Enter your system username and password for machine where the 
Reporting Server is installed or the username and password you were 
given to run the program. To change the username and password, 
see “Setting User Access” on page 229.

8. The Remote Interface Main Console opens.

9. Highlight the profile you want to report on, and click  Edit. 

10. From the Main Console, select the profile you want to report on from 
the Profile Description column. Double-click on the name, or click the 
Edit icon on the toolbar. The Profile Edit window opens.

11. Review the settings on the tabbed views, especially Report Header, 
Report Template, Reporting Method, and Reports.

12. When you have familiarized yourself with the components of a 
product profile, click OK. The window closes. You are returned to the 
Reporting Server Main Console.

13. To view the report you just created, click the Reports icon on the 
Main Console toolbar. The Report Viewer opens, displaying the report 
for the selected profile. Select the report chapters that you want to 
view from the Table of Contents section.



WebTrends Enterprise Reporting Server

90

 Figure 5-41.   Report Viewer

Pre-generated and on-demand reporting
You can configure the Reporting Server to run either Pre-generated or On-
demand reports. There are advantages to each report type.

Pre-generated reports
Pre-generated reports are those that are created and saved when the profile 
is processed so that they are available for users immediately simply by going 
to the URL where the report is posted. The Reporting Server program need 
not be running for users to access reports.

Decide at profile creation time what the reports for the profile should include. 
See “Preparing to analyze web site activity” on page 16 for details.

Note: Reports for new profiles are available immediately if the Start Initial 
Analysis Immediately... option in the Scheduler dialog was activated. Otherwise, 
reports are available at regular intervals beginning at the scheduled start time. See 
“Defining a schedule for processing” on page 196 for details.

On-demand reports
On-demand reports are those that are created as the report user requests 
them. Doing so dedicates time to analysis and other program processes. 

Use the 
Table of 
Contents 
for 
browsing 
report 
data
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Because on-demand reports are created as they are requested, disk space is 
saved. This method offers some flexibility not available in pre-generated 
reporting. For example, at report time, you can decide the tables and graphs 
to include, the number of items to include in report tables, and the style sheet 
to use. 

Profiles that have been set up to create pre-generated reports at the time the 
profile is processed can be viewed through your browser in the Report Viewer. 

To view reports for a profile:

1. Select the profile you want to report on from the Main Console.

2. Click Reports. The first page of the report is displayed in the Report 
Viewer.

 Figure 2-1.   First page of pre-generated report

3. Use the Report Calendar to select the dates or date range to view. If a 
report is available for a day or interval, a link appears in the calendar. 
The selected interval is highlighted in blue.

4. Use the Table of Contents to select the report chapter to view. 

Links indicate the 
report intervals that 

are available.

Loads the profile’s 
home page.

Status frame displays the 
report type and the date- 
and time-ranges reported 
on. Use the navigational 
arrows to scroll through 
the report.

The report frame displays 
the report chapter 
selected in the Table of 
Contents for the interval 
selected

Click to change the graph 
type. Click ? to view a 
help card for the report.

Table of Contents 
lists the chapters of 
the report. Click on 
an item to view it.

Use the Microsoft 
Word or Excel but-
tons to convert the 
HTML report. 
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Note: You can change the graph style by clicking the graph buttons that 
appear above the report. 

On-demand reports
Some profiles may have been set up to run on-demand reports; reports 
generated only when the user requests them. See “On-demand reports” on page 
92 for more information. 

Before you generate each report, you can modify the following settings:

• HTML page title lookup

• Tables and graphs to include

• Report style and language

• Report format

• Report header content.

To generate a on-demand report:

1. Select the profile you want to report on from the Main Console.

2. Click Reports. The Report Viewer opens displaying the report 
calendar.
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 Figure 5-42.  First page of on-demand report

3. Use the Report Calendar to select the dates or date range to 
generate. If a report can be generated for a day or interval, a link 
appears in the calendar. The report is generated and displayed.

4. Use the Table of Contents to select the report chapter to view. 

Using the job queue
You can view the profiles currently being processed and those waiting to be 
processed in the Job Queue. You can remove a profile, from the queue or 
stop processing at this dialog.

Removing an item from the queue only stops processing temporarily; it 
returns at the next scheduled interval.

Links indicate the 
report intervals that are 
available. Click a link to 

generate the report.

When the report 
generation is complete, 
the report frame 
displays the report 
chapter for the interval 
that you selected.

Click to change the graph type.

Table of Contents lists 
the chapters of the 
report. Click on an 

item to view it.
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 Figure 5-43.  Job Queue dialog

To view the Job Queue:

1. From the main console, select Views > Job Queues. The Job Queue 
dialog box opens (Figure 5-43).

The Current Analysis Queue lists the profiles that are currently being 
processed. Because the Reporting Server makes use of multi-threaded 
processing, several profiles may be analyzed at once. To interrupt 
processing, select a profile and click Stop. When a profile is stopped, it re-
enters the queue at the next scheduled time.

The Waiting Queue lists the profiles next in line for processing. The 
profile that will be processed next appears first in the list. Select a profile 
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and click Remove to remove it from the queue. It will return at the next 
scheduled interval.

Click Refresh to update the job list, if needed.

2. When you have completed browsing or editing the pending jobs, click 
Close.

 Viewing profile history
Use the Profile Home Page to view a history of reports generated for the 
profile selected. Here you can view the last time the profile was analyzed and 
the total number of reports generated for each report type.

1. Select the profile you want to report on from the Main Console.

2. Click the Report button, and the Report Viewer opens displaying the 
Profile Home Page.

 Figure 5-44.  Profile Home Page

3. Click a link in the calendar to view the report.



WebTrends Enterprise Reporting Server

96

Converting reports to Microsoft Word or Microsoft Excel
To convert Reporting Server reports to a format more easily sourced for 
presentations or other documentation, you can convert the Reporting Server 
HTML report to Microsoft Word or Excel via the Report Viewer. 

This conversion is possible if the workstation where you are running the 
Remote Interface meets the following criteria:

• The “System requirements” on page 22 must be met

• Microsoft Office must be installed on the workstation. 

• The "HTML, Microsoft Word, or Microsoft Excel" format must be 
activated in the Report Template for the profile. See 

The first time you select the MS Word or MS Excel option, the WebTrends 
conversion installation package is automatically downloaded. The installation 
package contains the files needed to convert HTML reports to Word or Excel 
format.   Once the converter files are on your system, the HTML report is 
downloaded to your system and converted to the format you specified.

Note:  You may be asked to provide your username and password during the 
installation of the MS Word installation package.

To convert your reports to Microsoft Word or Excel, complete these steps:

1. Select the profile that you want to report on.

2. Click Report on the toolbar.

3. Click the Microsoft Word or Excel icon that appears in the Report 
Calendar. The HTML report is converted to Microsoft format you 
selected.

  

 Figure 5-45.  The Report Calendar
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Working with Report Templates
You can tailor your reports using Report Templates. A report template defines 
the colors, language, and content of the report. The Reporting Server 
provides a set of report templates which are customizable. You can also 
create your own templates. As an Administrator, you can apply the template 
on a profile basis, or define this option globally and hide it from the user. 

Customizing reports
If you have been granted Administrative rights, you can define the following 
report settings by selecting the Style/Language tab from Templates:

• modify the color scheme (See “Changing the report color” on page 100)

• include or exclude help cards from generated reports. (“Adding report 
templates”, Step 1 though Step 5.

Adding report templates 

To create a new template, follow these steps:

1. From the Main Console, click Templates. The Report Template dialog 
opens (Figure 3-1 on page 98). All pre-defined styles appear in the list 
box.
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 Figure 3-1.   Report Template dialog

2. Click Add, The Add Report Template dialog opens (Figure 5-46).

 Figure 5-46.  Add Report Dialog
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Enter a name to identify the template in the Report Template field. 
The name will you add here now appears in the Options, Profile, and 
User Access window of the Reporting Server.

3. Select the Style/Language tab. Choose a style sheet to use from the 
drop-down list. To view the colors and fonts used in the style, click 
Preview.

4. Select the language for the reports from the drop-down list.

5. If you want to include Help Cards in reports that use this template, 
Click in the Help Cards check box. Help cards explain the tables of 
the report and describe how to use the information in the report.

6. Check Remove Chapters That Contain No Data box if you don’t 
want blank chapters included in the report. (You may have to scroll to 
view this option.)

7. Select the Format tab. The Format dialog opens (Figure 5-47). Choose 
whether you want both HTML, Microsoft Word, and Microsoft Excel 
reports.

.

 Figure 5-47.  Format dialog

8. Check the Single Content HTML page box if you want to save the 
report as one HTML file. If you do not select this option, each section 
is saved as a separate file. 
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Tip:  The HTML-only format generates more quickly, and uses 
less storage space.

9. Select the Content tab. The Content dialog opens (Figure 1-4)s. 
Check the boxes for which chapters to include in the report.

 

 Figure 5-48.  Content dialog

10. To specify the size of the table or graph, select the chapter in the list 
and enter the number in the Elements field. The greater the number, 
the more data included in the table or graph. 

11. To change the type of graph, select the graph in the list and click on 
the type you want to use. 

12. Click OK to save your settings.

Changing the report color
Report templates determine the color of your reports. The Reporting Server 
offers several color schemes to chose from.

To change the color, follow these steps:
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1. Click Template. The Report Template window opens.

2. Click Add, and enter a name for the template in the Report Template 
field.

3. In the Style/Language tab, select the style sheet you want to use. 
Click Preview to look at the style. Click OK to save the template. 

4. In the profile view, apply the template to profiles in the Report 
Template tab.

Changing the report language
The template determines the report language used. To run reports using a 
different language, you should create a new template using the language you 
chose. Because any changes to templates only apply to reports created after 
the change, you should either copy an existing profile or create a new profile 
that uses the new template. This method allows you to generate a consistent 
set of reports.

To change the language, follow these steps:

1. Click the Template button, and the Report Template window opens.

2. Click Add, and enter a name for the template in the Report Template 
field.

3. In the Style/Language tab, select the language to use.

4. Click OK to save your settings. 

Editing a report template
You can change settings for an existing template. Please note the modifying 
template settings will only affect reports generated after the change.

To modify an existing template, complete these steps:

1. Click the Template button, and the Report Template window opens.

2. Select the template that you want to modify from the list, and click 
Edit.

3. Make your changes.

4. Click OK to save your edits.
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Deleting a report template
You can delete a template if it is no longer used.

To remove a report template, follow these steps:

1. Click Template, and the Report Template window opens.

2. Select the template that you want to remove, and click Delete.

3. Click OK to save your changes.

Report data and Help Cards
With this version of the Reporting Server, you will find far more tables and 
graphs available for inclusion in your reports than before: over 150 different 
ways of analyzing your web site’s log file, depending on your site 
configurations, and the Reporting Server settings you have in place for each 
profile. 

For a complete list of available tables and graphs, generate a report on one of 
the sample databases included with the Reporting Server.

To generate a sample report, complete these steps:

1. Select a sample profile from the Reporting Server Main Console.

2. Click the Reports icon. A complete report will be generated for the 
profile you have selected. 

By default, generated reports include Help Card data: descriptions of a table 
and graph you are viewing, and how the data can be used to help improve 
your site.

You may find tables and graphs in your report which do not contain any data, 
due to a variety of configuration factors. Empty tables and graphs do not 
necessary signal an administrative error; it could be that your profile has not 
been configured to track the missing information.
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 Term Definition

Abandonment 
Rate

The percentage of shoppers who 
do not complete the sale of items 
placed in the shopping cart. This 
includes both cart abdandoners 
and checkout abandoners.

Ad A graphic or banner on a Web 
page that, when clicked on, takes 
the visitor to another site.

Ad Campaigns An effort to attract visitors to your 
site. It is usually, but not always, 
associated with a banner placed 
on another site which visitors 
click on to come to your site. It is 
characterized by a starting and 
ending date and a cost for the 
duration of the campaign.

Ad Clicks A click on an advertisement 
which takes a visitor to another 
Web site.

Ad Views When ads are seen by visitors. 
Once visitors have viewed an ad, 
they can click on them (see Ad 
Click). There may be more than 
one ad on an ad view.

Attempted Buyers Visitors who reached the 
checkout page, but did not 
complete the order.

Glossary
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Authenticated 
Visitor

A unique visitor tracked by 
username and password rather 
than by IP address. You may find 
more authenticated visitors than 
visitors because several persons 
may be using the same IP 
address. Since many ISPs 
dynamically assign IP addresses, 
and since multiple visitors may 
come from a single IP address, 
authentication is a much more 
accurate way to identify visitors.

Authentication Technique that limits access to 
Internet or intranet resources to 
those visitors who identify 
themselves by entering a 
username and password.

Bandwidth Measure (in kilobytes of data 
transferred) of the traffic on a site.

Browser A program used to locate and 
view Web pages. These include 
Netscape, Mosaic, Microsoft 
Internet Explorer, and others.

Buyers Visitors who have purchased at 
least one item on your Web site.

Cart Abandoners

Checkout 
Abadoners

Shoppers who began the check-
out process, but did not reach the 
final check-out page.

Click Through 
Rate

Percentage of visitors who click 
on a viewed ad. This is a good 
indication of an ad’s 
effectiveness.

Client The browser used by a visitor to a 
Web site.

 Term Definition
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Client Errors An error occurring due to an 
invalid request by the visitor’s 
browser. Client errors are in the 
400-range. See the "Return 
Code" glossary entry for more 
information.

Company 
Database

The database installed and used 
by WebTrends to look up the 
company name, city, state, and 
country corresponding to a 
specific domain name.

Content Group A defined group of Web pages 
with specific things in common, 
such as the same types of 
products, services, or 
information.

Conversion Rate Percentage of visitors who 
purchase at least one item.

Cookies Files containing information about 
Web site visitors. This information 
can include the visitor’s 
username, preferences, etc. The 
information is provided by visitors 
during their first visit to a Web 
site. The server records this 
information in a text file and 
stores it on the visitor’s hard 
drive. At the beginning of later 
visits, the server looks for a 
cookie and configures itself 
based on the information 
provided.

Cost Per Non-
qualified Visit

Amount spent on a campaign 
divided by the number of non-
qualified visitors brought to your 
site by the campaign.

 Term Definition
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Cost Per Product 
Qualification

Amount of money spent on a 
marketing campaign divided by 
the number of product 
qualifications the campaign was 
responsible for.

Cost Per Qualified 
Visit

Amount spent on a marketing 
campaign divided by the number 
of qualified visitors brought to 
your site by the campaign.

Cost Per Visit Amount spent on a marketing 
campaign divided by the number 
of visitors brought to your site by 
the campaign.

Cost This Period Cost of a media campaign during 
this report period.

Destination Page A page that many visitors look at 
when they come to your site. The 
list of pages in the Paths to 
Destination column are the pages 
that visitors viewed on their way 
to the destination page.

Documents Pages that were defined as 
"documents" by the system 
administrator. Typically, a page 
will be defined as a document if 
the content is static, such as a 
complete HTML page. However, 
the administrator has the option 
of defining dynamic pages and 
forms as documents if he or she 
chooses.

Domain Name The text name corresponding to 
the numeric IP address of a 
computer on the Internet. For 
example, www.webtrends.com is 
a domain name.

 Term Definition
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Domain Name 
Lookup

The process of converting a 
numeric IP address into a text 
name (for example, 
204.245.240.194 is converted to 
www.webtrends.com).

Dynamic Pages Pages, such as those generated 
by search engines, that are 
created with variables and do not 
exist anywhere in a static form. 
They are generated from a 
database based on values that 
visitors select. WebTrends counts 
any line with a Post command or 
a Get command with a "?" as a 
dynamic page.

Engagement Rate Percentage of visitors who 
become shoppers.

Entry Page The first page a visitor sees when 
entering your Web site. To qualify 
as an entry page the visit must 
start with a valid document type. 
If a session starts at a document 
with a different type (such as a 
graphic or sound file), the file 
does not count as an entry page, 
and the session is not included in 
the total. Such sessions are often 
the result of other sites 
referencing a specific 
downloadable file or graphic on 
your site. In these cases, a 
session may have a single hit to a 
non-document type file, and will 
not be counted in the percentage 
calculations.

 Term Definition
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Exit Page The last page a visitor views 
before leaving your Web site. To 
qualify as an exit page the visit 
must end with a valid document 
type. If a session ends on a 
document with a different type 
(such as a graphic or sound file), 
the file does not count as an exit 
page, and the session is not 
included in the total. Such 
sessions are often the result of 
other sites referencing a specific 
downloadable file or graphic on 
your site. In these cases, a 
session may have a single hit to a 
non-document type file, and will 
not be counted in the percentage 
calculations.

FTP File Transfer Protocol. It is a 
standard method of sending files 
from one computer to another 
over the Internet.

File Type Identifies types of files by their 
three-character extension. For 
example, a file named graphic.gif 
is identified as type gif.

Filters A means of narrowing the scope 
of a report by specifying ranges 
or types of data to include or 
exclude.

Forms Scripted pages which pass 
variables back to the server. 
These pages are used to gather 
information from visitors.

GIF Graphics Interchange Format. It 
is a graphics file format 
commonly used in HTML 
documents.

 Term Definition
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HTML Hyper Text Markup Language. It 
is the programming language for 
static Web pages. It usually 
specifies hypertext links between 
related objects and documents.

HTTP HyperText Transfer Protocol. It is 
a standard method of transferring 
data between a Web server and a 
Web browser.

Hit A single action on the Web server 
as it appears in the log file. A 
visitor downloading a single file is 
logged as a single hit, while a 
visitor requesting a Web page 
including two images registers as 
three hits on the server; one hit is 
the request for the .html page, 
and two additional hits are 
requests for the downloaded 
image files. While the volume of 
hits is an indicator of Web server 
traffic, it is not an accurate 
reflection of how many pages are 
being looked at.

Home Page The main or introductory page of 
a Web site. The home page 
provides visitors with an overview 
and links to the rest of the site. It 
often contains or links to a Table 
of Contents.

Home Page URL The URL for the home page of 
the site analyzed in the report.

IP Address Internet Protocol Address. It is a 
series of four one- to three-digit 
numbers separated by periods. It 
is used to identify a computer 
connected to the Internet. For 
example, 212.6.125.76 is an IP 
address.

 Term Definition
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JPEG Joint Photographic Expert Group. 
It is a compressed graphics 
format common on the Internet.

Log File A file created by a Web or proxy 
server which contains information 
about the activity of the server.

Marketing 
Campaign

An effort to attract visitors to a 
site. It is usually, but not always, 
associated with a banner ad 
placed on another Web site which 
visitors can click on. It is 
characterized by a starting and 
ending date and a cost for the 
duration of the campaign.

New Users Visitors who didn’t have a cookie 
on their first hit, but had one on 
later hits.

No Refferer Indicates visits to your Web site 
that did not originate from any 
other site. For example, any 
visitor who types the URL of your 
site directly into their browser 
window fits into this category.

Non-qualified 
Revenue Forecast

This number is generated by 
counting the number of non-
qualified visits and multiplying by 
the value assigned to non-
qualified visits. The value of non-
qualified visits is assigned by the 
system administrator.

 Term Definition



111

Non-qualified 
Visits

Visits by customers who did not 
meet the minimum qualifications 
for potential revenue generators 
based on their traffic pattern. 
These visits have less potential 
value than qualified visits, but 
should not be discounted entirely. 
The visitors may become more 
valuable qualified visitors in the 
future.

Page Any document, dynamic page, or 
form. Documents are defined by 
the system administrator, but 
generally include all static 
content, such as complete html 
pages. Dynamic pages, such as 
those generated by search 
engines, are created with 
variables and do not exist 
anywhere in a static form. Forms 
are scripted pages which get 
information from a visitor that 
gets passed back to the server.

Page Views Hits to documents, dynamic 
pages, and forms. Hits to images, 
audio files, video files, forms, and 
ads are not counted.

Path Through Site The path a visitor takes from the 
entry page to the exit page. The 
default definition for a page in this 
context is defined as a document 
ending with the extension .htm, 
.html, or .asp. This definition can 
be changed by the system 
administrator.

Paths from Start With the exception of the starting 
page, the path a visitor takes to a 
destination or exit page.

 Term Definition
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Paths to 
Destination

A list of pages in the order they 
were viewed to arrive at the 
specified destination page.

Platform Refers to the operating system, 
such as Linux or Windows 98.

Product Category The product category is defined 
by the system administrator in 
Product Definitions.

Product 
Qualification

A visitor who qualifies as a 
revenue generator for a specific 
product results in one product 
qualification. A visitor can trigger 
product qualifications for more 
than one product, depending on 
how many products they 
purchase or are sufficiently 
interested in.

Projected Non-
qualified Visits

Number of non-qualified visitors 
expected to be drawn to your site 
from a marketing campaign. The 
number of actual non-qualified 
visitors so far are included. The 
final number is a projection based 
on how many days the campaign 
has run, how many non-qualified 
visitors were attracted during that 
time, and how many days are left 
in the campaign. The projected 
number will be accurate if the 
campaign’s future performance is 
the same as its past performance.
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Projected Product 
Qualifications

Number of product qualifications 
expected on your site from a 
marketing campaign or product. 
The number of product 
qualifications so far are included. 
The final number is a projection 
based on how many days the 
campaign has run, how many 
product qualifications were 
attracted during that time, and 
how many days are left in the 
campaign. The projected number 
will be accurate if the campaign’s 
future performance is the same 
as its past performance.

Projected 
Qualified Visits

Number of qualified visitors 
expected to be drawn to your site 
from a marketing campaign. The 
number of actual qualified visitors 
so far are included. The final 
number is a projection based on 
how many days the campaign 
has run, how many qualified 
visitors were attracted during that 
time, and how many days are left 
in the campaign. The projected 
number will be accurate if the 
campaign’s future performance is 
the same as its past performance.

 Term Definition
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Projected Visits Number of visitors expected to be 
drawn to your site from a 
marketing campaign. The number 
of actual visitors so far are 
included. The final number is a 
projection based on how many 
days the campaign has run, how 
many visitors were attracted 
during that time, and how many 
days are left in the campaign. The 
projected number will be accurate 
if the campaign’s future 
performance is the same as its 
past performance.

Protocol An established method of 
exchanging data over the 
Internet.

Qualification Level Level of qualification of visitors to 
your Web site; fully qualified, 
moderately qualified, or minimally 
qualified. These levels are 
defined by the system 
administrator in Product 
Definitions.

Qualified Revenue 
Forecast

This number is generated by 
counting the number of qualified 
visits and multiplying by the value 
assigned to each visit. Each 
qualification level (full, moderate, 
and minimal) can have separate 
values assigned to them. The 
"Products Summary" page of this 
report lists the value assigned to 
each qualification level for each 
product. The values are assigned 
by the system administrator.
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Qualified Visits Visits by customers who are 
considered qualified as revenue 
generators. To qualify, a visitor 
must access specific pages on 
your Web site that are specified 
by the system administrator.

Referrer URL of a Web page that refers 
visitors to your site.

Return Code

Partial list of 
"Success" codes:

200 = Success: OK

201 = Success: Created

202 = Success: Accepted

203 = Success: Partial 
Information

204 = Success: No Response

205 = Success: Cached

206 = Success: Partial Content

300 = Success: Redirected

301 = Success: Moved

302 = Success: Found

303 = Success: New Method

304 = Success: Not Modified

305 = Success : Use Proxy

Partial list of 
"Failed" codes:

 Term Definition
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400 = Failed: Bad 
Request

401 = Failed: Unauthorized 
Access

402 = Failed: Payment Required

403 = Failed: Forbidden Access

404 = Failed: Page or File Not 
Found

405 = Failed: Method Not 
Allowed

406 = Failed: Not Acceptable

407 = Failed: Proxy 
Authentication Required

408 = Failed: Request Timeout

409 = Failed: Conflict

410 = Failed: Gone

411 = Failed: Length Required

412 = Failed: Precondition Failed

413 = Failed: Request Entity Too 
Large

414 = Failed: Request-URI Too 
Large

415 = Failed: Unsupported Media 
Type

500 = Failed: Internal Error

501 = Failed: Not Implemented

502 = Failed: Temporarily 
Overloaded

503 = Failed: Service 
Unavailable

504 = Failed: Gateway Timeout
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505 = Failed: HTTP Version Not 
Supported

Returning Visitors Visitors who already had a cookie 
from your site before they visited.

Revenue Forecast This number is generated by 
counting the number of visits and 
multiplying by the value assigned 
to each type of visit. The 
"Products Summary" page of this 
report lists the value assigned to 
each qualification level for each 
product. The values are assigned 
by the system administrator.

Server A computer that hosts information 
available to anyone accessing the 
Internet or an internal intranet.

Server Error An error occurring on the server. 
Web server errors have codes in 
the 500 range.

Shoppers Visitors who placed at least one 
item in a shopping cart. If they 
didn’t purchase any items, they 
still count as shoppers.

 Term Definition
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Single Access 
Page

A page on your Web site that 
visitors open, then exit from, 
without viewing any other page. 
To qualify the visit must be to a 
page with a valid document type. 
If the visit is to a document with a 
different type (such as a graphic 
or sound file), the file does not 
count as a single access page, 
and the visit is not included in the 
total. Such visits are often the 
result of other sites referencing a 
specific downloadable file or 
graphic on your site. In these 
cases, a visit may have a single 
hit to a non-document type file, 
and will not be counted in the 
percentage calculations.

Spider An automated program which 
searches the internet.

Suffix (Domain 
Name)

The three digit suffix of a domain 
name can be used to identify the 
type of organization the Web site 
belongs to.

Partial list of 
domain name 
suffixes:

.com = Commercial

.edu = Educational

.int = International

.gov = Government

.mil = Military

.net = Network

.org = Organization

Time Interval A one-year report displays 
monthly time increments. A one-
month report displays daily time 
increments. And a daily report 
displays hourly time increments.

 Term Definition
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URL Uniform Resource Locator. It is a 
means of identifying an exact 
location on the Internet. For 
example, http://
www.webtrends.com/html/info/
default.htm is the URL which 
defines the location of the page 
Default.htm in the /html/info/ 
directory on the WebTrends 
Corporation Web site. As the 
previous example shows, a URL 
is comprised of four parts: 
Protocol Type (HTTP), Machine 
Name (webtrends.com), Directory 
Path (/html/info/), and File Name 
(default.htm).

Unique Visitors Individuals who visited your site 
during the report period. If 
someone visits more than once, 
they are counted only the first 
time they visit.

User Agent Portion of a log file that identies 
the browser and platform used by 
a visitor.

Users Without 
Cookies

Visitors who come to your site 
with cookies disabled. There is no 
way to determine if these visitors 
are new or returning.

Visit All the activity, from beginning to 
end, of one visitor to a Web site. If 
a visitor is idle longer than the 
idle-time limit, WebTrends 
assumes the visit was voluntarily 
terminated. If the visitor continues 
to browse your site after they 
reach the idle-time limit, a new 
visit is counted. The default idle-
time limit is thirty minutes. This 
time limit can be changed by the 
system administrator.
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Visit Duration 
(Minutes)

The number of minutes your Web 
site was viewed.

Visitor-Minutes Total number of minutes your site 
was viewed by all visitors put 
together during the specified time 
frame.

Visits With Clicks Visits to your site that resulted in 
an ad being clicked on.

 Term Definition
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